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About This Online Help

This help guide describes how to use the BEA® Log Central application to manage log 
messages. The guide is organized as follows:

n Chapter 1, “Overview,” describes the Log Central architecture.

n Chapter 2, “Introducing the Log Central Console,” explains how to start the Log 
Central Console.

n Chapter 3, “Managing Log Messages,” explains how to monitor log messages.

n Chapter 4, “Changing Message Definitions and Subsystem Descriptions,” 
explains how to modify message definitions and subsystem descriptions.

n Chapter 5, “Generating Reports,” explains how to generate reports.

n Chapter 6, “Configuring SNMP Traps,” explains how to configure SNMP traps.

n Chapter 7, “Managing the Database and Intermediate Files,” explains how to 
manage database files and intermediate files.

n Chapter 8, “Testing and Debugging,” explains how to test and debug.

n Appendix A, “Log Central Message and Message Definition Formats,” describes 
the Log Central message format.

n Appendix B, “Commands,” describes the Log Central commands.

n Appendix C, “SNMP Traps,” describes the SNMP traps that Log Central defines.
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What You Need to Know

This document is written for system administrators and network administrators who 
set up and manage Log Central. It assumes a working knowledge of relational 
databases and JDBC. If you use the SNMP feature, then you also need to have a 
working knowledge of SNMP.

e-docs Web Site

BEA product documentation is available on the BEA corporate Web site. From the 
BEA Home page, click Product Documentation or go directly to the e-docs Product 
Documentation page at http://e-docs.bea.com/.

How to Print the Document

You can print a copy of this document from a Web browser, one file at a time, by using 
the File—>Print option on your Web browser. (Be sure to first click anywhere within 
the HTML content frame you want to print, so that that frame is selected.)

The Log Central Online Help is also available as a PDF in the Log Central online 
documentation set, which is available on the e-docs Web site and also on the Log 
Central product CD. You can open the PDF in Adobe Acrobat Reader and print the 
entire document (or a portion of it) in book format. To access the PDFs, open the Log 
Central documentation Home page, click the PDF files button and select the document 
you want to print.

If you do not have the Adobe Acrobat Reader, you can get it for free from the Adobe 
Web site at http://www.adobe.com/.
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Related Information

For more information about Log Central, see the Log Central online documentation set 
which is available on the Log Central product CD and at the e-docs Product 
Documentation page at http://e-docs.bea.com/.

Contact Us!

Your feedback on the BEA Log Central documentation is important to us. Send us 
e-mail at docsupport@bea.com if you have questions or comments. Your comments 
will be reviewed directly by the BEA professionals who create and update the Log 
Central documentation.

In your e-mail message, please indicate that you are using the documentation for the 
BEA Log Central 5.0 release.

If you have any questions about this version of BEA Log Central, or if you have 
problems installing and running BEA Log Central, contact BEA Customer Support 
through BEA WebSupport at http://www.bea.com. You can also contact Customer 
Support by using the contact information provided on the Customer Support Card, 
which is included in the product package.

When contacting Customer Support, be prepared to provide the following information:

n Your name, e-mail address, phone number, and fax number

n Your company name and company address

n Your machine type and authorization codes

n The name and version of the product you are using

n A description of the problem and the content of pertinent error messages
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Documentation Conventions

The following documentation conventions are used throughout this document.

Convention Item

boldface text Indicates terms defined in the glossary.

Ctrl+Tab Indicates that you must press two or more keys simultaneously.

italics Indicates emphasis or book titles.

monospace 
text

Indicates code samples, commands and their options, data structures and 
their members, data types, directories, and file names and their extensions. 
Monospace text also indicates text that you must enter from the keyboard.

Examples:

#include <iostream.h> void main ( ) the pointer psz

chmod u+w *

\tux\data\ap

.doc

tux.doc

BITMAP

float

monospace 
boldface 
text

Identifies significant words in code.

Example:

void commit ( )

monospace 
italic 
text

Identifies variables in code.

Example:

String expr

UPPERCASE 
TEXT

Indicates device names, environment variables, and logical operators.

Examples:

LPT1

SIGNON

OR
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{ } Indicates a set of choices in a syntax line. The braces themselves should 
never be typed.

[ ] Indicates optional items in a syntax line. The brackets themselves should 
never be typed.

Example:

buildobjclient [-v] [-o name] [-f file-list]... 
[-l file-list]...

| Separates mutually exclusive choices in a syntax line. The symbol itself 
should never be typed.

... Indicates one of the following in a command line: 

n That an argument can be repeated several times in a command line

n That the statement omits additional optional arguments

n That you can enter additional parameters, values, or other information

The ellipsis itself should never be typed.

Example:

buildobjclient [-v] [-o name] [-f file-list]... 
[-l file-list]...

.

.

.

Indicates the omission of items from a code example or from a syntax line. 
The vertical ellipsis itself should never be typed.

Convention Item
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CHAPTER
1 Overview

The following sections provide an overview of Log Central:

n Log Messages in System Management

n Log Messages in Log Central

n Log Central Architecture
l Overview of Log Central Architecture
l Data Collection Agent
l Log Monitor
l Message Sender
l Central Collector
l Message Receiver
l Message Processor

n Construction of Log Messages

n Log Central Processes
l Overview of the Log Central Processes
l Process Monitor

n SNMP Integration

n Fault Tolerance

n Log Central Console
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1 Overview
Log Messages in System Management

Log messages are typically used as a system management tool: to detect problems, 
track down the source of a fault, or track system performance. Distributed systems 
include a variety of software components that generate message logs, such as operating 
systems and relational database management systems (RDBMS). In the absence of an 
industry-wide standard, software makers use different practices for message logging.

Log Messages in Log Central

Log Central extracts information from different kinds of logs and maps the information 
into a common format. Log Central stores the reformatted log messages in a relational 
database, which gives you a single point of access and a unified view of the log 
messages. Thus, Log Central makes it easier for you to manage your distributed 
systems.

A single failure, such as a file system filled to capacity, can generate multiple log 
messages as the problem ripples through the affected software. A unified view of the 
log messages lets you diagnose the source of a problem more rapidly. 

Log Central helps you manage BEA products such as BEA Tuxedo®, BEA WebLogic 
Enterprise™, and BEA WebLogic Server™. You can also use Log Central to manage 
databases, operating systems, and any other software programs that generate log 
messages.
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Log Central Architecture
Log Central Architecture

The following sections describe the Log Central architecture:

n Overview of Log Central Architecture

n Data Collection Agent

n Log Monitor

n Message Sender

n Central Collector

n Message Receiver

n Message Processor

Overview of Log Central Architecture

Log Central is based on an agent/manager architecture as shown in the following 
figure. A managed node is a machine that has resources that need to be managed. A 
managed resource is a software component such as a BEA Tuxedo application, an 
operating system, or an RDBMS. The central host and each managed node has a Log 
Central Data Collection Agent. The Data Collection Agents forward log messages to 
the Central Collector, which stores log messages in a database and provides 
information to the Log Central Console. Data Collection Agents and the Central 
Collector can generate SNMP traps. The Log Central Console, the Central Collector, 
and the Log Central database play the manager role in the Log Central architecture.
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1 Overview
Figure 1-1   Log Central Architecture
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Log Central Architecture
Data Collection Agent

A Data Collection Agent resides on a managed node or the central host. A Data 
Collection Agent consists of a Message Sender, a queue, and one or more Log 
Monitors. The following figure shows the flow of log information from managed 
resources through a Data Collection Agent to the Central Collector.

Figure 1-2   Data Collection Agent
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1 Overview
Log Monitor

A Data Collection Agent needs a Log Monitor for each managed resource. The Log 
Monitor receives log messages from the managed resource and maps these messages 
into the Log Central message format before putting them in the queue. For information 
about mapping, see Chapter 5, “Creating Log Mappings,” in the Log Central 
Configuration Guide.

Message Sender

The Message Sender reads messages from the queue and forwards them to the Central 
Collector. You can create filters that direct the Message Sender to do the following:

n Discard (not forward) specified messages.

n Save specified message to a file.

n Send an SNMP trap when a specified message is received.

n Run a script or program when a specified message is received.

For information about creating filters, see Chapter 7, “Creating Filters,” in the Log 
Central Configuration Guide.
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Log Central Architecture
Central Collector

The Central Collector resides on the central host and consists of a Message Receiver, 
intermediate files, and a Message Processor. The following figure shows the flow of 
log information in the Central Collector.

Figure 1-3   Central Collector
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1 Overview
Message Receiver

After receiving a log message from a Data Collection Agent, the Message Receiver 
puts the message in an intermediate file. The Message Receiver creates a new 
intermediate file every hour. Use the Storage Maintenance tool, which is in the Log 
Central Console, to control how frequently the Message Receiver deletes intermediate 
files.

Message Processor

The Message Processor performs the following functions:

n Retrieves log messages from the intermediate files and puts them in the Log 
Central database

n Handles requests from the Log Central Console, such as database queries or 
forwarding of incoming messages for online monitoring

n Generates SNMP trap notifications for log messages that are mapped to SNMP 
traps

Construction of Log Messages

Log Central constructs log messages as described in the following steps and diagram:

1. When a Log Monitor receives a log message, it maps the message header and 
message body into the Log Central message format. Then the Log Monitor 
forwards the message to the Message Sender, which forwards the message to the 
Central Collector.

For information about how the Log Monitor maps messages, see Chapter 5, 
“Creating Log Mappings,” in the Log Central Configuration Guide. For 
information about the Log Central message format, see Appendix A, “Log 
Central Message and Message Definition Formats.”
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Log Central Processes
2. When the Central Collector receives the reformatted log message from the 
Message Sender, it uses the message’s subsystem and message ID fields to find a 
corresponding message definition in a message definition file. Message definition 
files are in the Log Central database. 

For information about message definitions, see Chapter 6, “Creating Message 
Definitions,” and Appendix A, “Log Central Message and Message Definition 
Formats,” in the Log Central Configuration Guide.

3. The Central Collector appends the message definition to the message.

Figure 1-4   Construction of Log Messages

Log Central Processes

The following sections describe the Log Central processes:

n Overview of the Log Central Processes

n Process Monitor
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1 Overview
Overview of the Log Central Processes

The following figure shows the Log Central processes.

Figure 1-5   Log Central Processes
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Log Central Processes
When you call the start_messaging process on the central host, it starts the 
following processes:

n Message Receiver (msg_receiver) 

n Message Processor (msg_processor) 

n Process Monitor (proc_monitor) 

n Message Sender (msg_sender) 

n Log Monitors (log_monitor) if you included LOG_MONITOR statements in the 
MANAGED_NODE entry in the messaging configuration file. 

When you call the start_messaging process on a managed node, it starts the 
following processes:

n Message Sender (msg_sender) 

n Process Monitor (proc_monitor) 

n Log Monitors (log_monitor) if you included LOG_MONITOR statements in the 
MANAGED_NODE entry in the messaging configuration file. 

The start_messaging process on a managed node connects to the 
start_messaging process on the central host.

Process Monitor

The Process Monitor is a daemon that runs on the central host and each managed node. 
The following processes register with the Process Monitor at startup:

n start_messaging

n Log Monitor (log_monitor)

n Message Sender (msg_sender)

n Message Receiver (msg_receiver)

n Message Processor (msg_processor)
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1 Overview
At fixed intervals, the Process Monitor checks all registered processes. If configured 
to do so, it restarts dead processes with the user and group IDs that were passed to it at 
startup.

SNMP Integration

Log Central enables you to use Simple Network Management Protocol (SNMP) to 
integrate information from logs into an enterprise management system. You can 
specify the following kinds of traps:

n Basic traps

You use the Basic Trap Configuration window, which is part of the Log Central 
Console, to map log messages to SNMP traps. The Central Collector generates 
an SNMP trap when it receives a log message that is mapped to an SNMP trap.

n Advanced traps

You can create filters in the Log Central messaging configuration file to specify 
advanced criteria for triggering SNMP traps. A Data Collection Agent generates 
an SNMP trap when it receives a message that matches the criteria. For 
information about creating filters, see Chapter 7, “Creating Filters,” in the Log 
Central Configuration Guide.

Fault Tolerance

You can configure a secondary Central Collector as a backup for the primary Central 
Collector. If the primary Central Collector becomes unavailable, the Data Collection 
Agents automatically send the log messages to the secondary Central Collector. 
Control automatically switches back to the primary Central Collector when it becomes 
available. The primary Central Collector can access the messages that were sent to the 
secondary Central Collector if both collectors use the same database. For information 
about configuring a secondary Central Collector, see Chapter 3, “Configuring the 
Central Host,” in the Log Central Configuration Guide.
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Log Central Console
If none of the Central Collectors configured for a Data Collection Agent are accessible, 
the Data Collection Agents save the log messages to a temporary local file. When the 
Central Collector becomes available, the Data Collection Agents recover the messages 
from the temporary files and forward them to the Central Collector. During recovery, 
new incoming messages have the highest priority and recovered messages are 
forwarded when the Data Collection Agents are not handling new messages. The Data 
Collection Agents delete the temporary files after the messages have been forwarded. 

Log Central Console

The Log Central Console is a graphical user interface that lets you access the log 
messages that the Central Collector receives. You can use the Log Central Console to 
analyze problems and track trends. For more information about the console, see 
Chapter 2, “Introducing the Log Central Console.”
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CHAPTER
2 Introducing the Log 
Central Console

The Log Central Console is a graphical user interface that provides tools for:

n Managing Log Messages

n Changing Message Definitions and Subsystem Descriptions

n Generating Reports

n Configuring SNMP Traps

n Managing the Database and Intermediate Files

To configure and start the Log Central Console:

1. Modify PATH to include the directory that contains a Web browser. By default, the 
Log Central Console uses Netscape Navigator to display the online help. To use a 
non-default browser, set the -b option when you start the Log Central Console. 

2. Run start_messaging on the central host.

3. Wait approximately one minute. This wait time allows the Log Central processes 
to start.

4. Run lc_launch on the central host.

For information about the start_messaging and lc_launch commands, see 
Appendix B, “Commands.”
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2 Introducing the Log Central Console
When you start the Console, the Launch Panel appears first.

Figure 2-1   Launch Panel

The following table describes the buttons on the Launch Panel.

Table 2-1  Buttons on the Launch Panel

Button What the Button Does More Information

Msg Browser Starts the Message Browser, which enables you 
to monitor and filter log messages.

Chapter 3, “Managing Log Messages.”

Msg Def Edit Starts the Message Definition Editor which 
enables you to modify and filter message 
definitions and modify subsystem descriptions.

Chapter 4, “Changing Message 
Definitions and Subsystem Descriptions.”

Basic Trap Starts the Basic Trap Configuration window, 
which enables you to configure basic traps.

Chapter 6, “Configuring SNMP Traps.”

Storage Maint Starts the Storage Maintenance tool, which 
enables you to manage the Log Central database 
and intermediate files.

Chapter 7, “Managing the Database and 
Intermediate Files.”

Help Displays the Log Central Online Help. —
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CHAPTER
3 Managing Log 
Messages

The following sections describe the functions of the Message Browser:

n Working with the Message Browser

n Monitoring Incoming Log Messages

n Querying the Database

n Filtering Log Messages

n Deleting Log Messages

n Acknowledging Log Messages

n Removing Acknowledgments

n Viewing Log Message Definitions

For a description of the log messages, see Appendix A, “Log Central Message and 
Message Definition Formats.”
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3 Managing Log Messages
Working with the Message Browser

The following sections explain how to use the Message Browser:

n Starting the Message Browser

n Main Components of the Message Browser

n Message Browser Toolbar

n Message Browser Menus

n Changing the Log Message Layout

n Changing Severity Colors

Starting the Message Browser

To start the Message Browser:

1. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, “Introducing 
the Log Central Console.” For the lc_launch command syntax, see 
Appendix B, “Commands.”
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Working with the Message Browser
2. Click Msg Browser. Log Central displays the Message Browser.

Figure 3-1   Message Browser

Main Components of the Message Browser

The following table describes the main components of the Message Browser.

Table 3-1  Main Components of the Message Browser

Component Description

Menu bar Provides the menus for the Message Browser. For more information, see “Message 
Browser Menus.”

Toolbar Provides access to frequently used actions. For more information, see “Message Browser 
Toolbar.”

Unacknowledged 
field

Displays the number of messages in the message pane that have not been acknowledged. 
The Message Browser displays a value in this field when you perform online monitoring 
or query the database.
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3 Managing Log Messages
Message Browser Toolbar

The following table describes the Message Browser toolbar. On the toolbar, all options 
except Stop and Help are inactive if the Message Browser is receiving real-time 
incoming messages or querying the database.

Displayed/Matched 
field

When you query the database, this field displays the number of messages that satisfy the 
filter settings and the number of messages displayed. These numbers differ if the query 
found more messages than the maximum that can be displayed. To configure the 
maximum number of messages that can be displayed, use the -n option when you start 
the Log Central Console. 

For information about filter settings, see “Filtering Log Messages.” For information 
about the -n option, see the description of the lc_launch command in Appendix B, 
“Commands.”

Online Monitoring 
button

When you click Start, directs the Log Central Console to monitor and display log 
messages in real time as they arrive at the Central Collector. The Message Browser 
displays real-time incoming messages that satisfy the filter settings, with the most recent 
message displayed at the top of the message pane. For information about the filter 
settings, see “Filtering Log Messages.”

Historical Query 
button

When you click Start, directs the Log Central Console to query the Log Central database. 
The Message Browser displays messages in the database that satisfy the filter settings, 
with the most recent message displayed at the top of the message pane. For information 
about the filter settings, see “Filtering Log Messages.”

Message pane Displays log messages.

Table 3-1  Main Components of the Message Browser

Component Description

Table 3-2  Message Browser Toolbar

Button Action

Retrieves and displays real-time incoming messages or messages that are in the Log 
Central database, depending on whether you selected Online Monitoring or Historical 
Query in the Message Browser. The Message Browser displays messages that satisfy the 
filter settings, with the most recent message displayed at the top of the message pane. For 
information about the filter settings, see “Filtering Log Messages.”
3-4 Log Central Online Help



Working with the Message Browser
Stops retrieval of messages. This button is inactive if messages are not being retrieved.

Displays the Layout Definition window, in which you specify the message fields to 
display and the order in which to display them. For information about using the Layout 
Definition window, see “Changing the Log Message Layout.” You can also use the 
Layout Definition command in the Settings menu to display the Layout Definition 
window.

Displays the Filter Settings window, in which you can:

n Define the criteria for determining which messages to display in the message pane

n Select the sort order for messages from a database query

For information about using the Filter Settings window, see “Filtering Log Messages.” 
You can also use the Browser Filter command in the Settings menu to display the Filter 
Settings window.

Displays the Message Colors window, which enables you to change the colors for the 
severity levels. For information about using the Color Settings window, see “Changing 
Severity Colors.” You can also use the Message Colors command in the Settings menu 
to display the Message Colors window.

Displays the Log Central Online Help. You can also use the commands in the Help menu 
to display the Log Central Online Help.

Table 3-2  Message Browser Toolbar

Button Action
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3 Managing Log Messages
Message Browser Menus

The following table describes the Message Browser menus.

Table 3-3  Message Browser Menus

Menu Commands

File Reports—Generates a report of the messages retrieved from a database query. This option 
is inactive if the Message Browser is in online monitoring mode. A submenu lets you 
generate a summary report or a detail report. A summary report groups messages by 
subsystem and presents the message totals for each severity level and log level. A detail 
report provides most of the message fields for each message. For more information about 
generating reports, see Chapter 5, “Generating Reports.”

Close—Exits the Message Browser.

Edit Delete—Deletes the selected messages.

View Message Details—Displays the Message Details window, which displays the message 
body and message definition for the selected message.

Settings Browser Filter—Displays the Filter Settings window, in which you can:

n Define the criteria for determining which messages to display in the message pane

n Select the sort order for messages from a database query

For information about using the Filter Settings window, see “Filtering Log Messages.” You 
can also use the Filter button in the toolbar to display the Filter Settings window.

Layout Definition—Displays the Layout Definition window, in which you can specify the 
message fields to display and the order in which to display them. For information about 
using the Layout Definition window, see “Changing the Log Message Layout.” You can 
also use the Layout button in the toolbar to display the Layout Definition window.

Message Colors—Displays the Message Colors window, which enables you to change the 
colors for the severity levels. For information about using the Color Settings window, see 
“Changing Severity Colors.” You can also use the Colors button in the toolbar to display 
the Message Colors window.
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Changing the Log Message Layout

You can change the fields to display in the Message Browser message pane. You can 
also change the order in which the fields are displayed. 

To change the message layout:

1. Start the Message Browser:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Browser. Log Central displays the Message Browser.

Actions Start—Retrieves and displays real-time incoming messages or messages that are in the Log 
Central database, depending on whether you selected Online Monitoring or Historical 
Query in the Message Browser. The Message Browser displays messages that satisfy the 
filter settings, with the most recent message displayed at the top of the message pane. For 
information about the filter settings, see “Filtering Log Messages.”

Stop—Stops the database query or online monitoring.

Acknowledge—Acknowledges the selected messages.

Clear Acknowledgment—Clears the acknowledgments for the selected messages.

Help Displays the Log Central Online Help for various Message Browser help topics. You can 
also use the Help button in the toolbar to display the Log Central Online Help.

Table 3-3  Message Browser Menus

Menu Commands
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2. Click Layout.

The Message Browser displays the Layout window.

Figure 3-2   Message Browser Layout Window

3. Select the fields to show or hide. 

Use the Show and Hide buttons to move selections from one list to the other.

4. Use the up and down arrows to change the order in the Show list.
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5. To save these settings as the default for the current database user, select Save to 
Database.

6. Click OK.

Changing Severity Colors

The following table shows the default severity colors.

To change the severity colors:

1. Start the Message Browser or the Message Definition Editor:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Browser or Msg Def Edit. Log Central displays the Message 
Browser or Message Definition Editor.

Table 3-4  Default Severity Colors

Severity Default Color

Informational Green

Warning Yellow

Minor Blue

Major Magenta

Critical Red
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2. Click Colors.

The Log Central Console displays the Color Settings window.

Figure 3-3   Color Settings Window

3. Select the severity level to change.

4. Move the Red, Green, and Blue sliders to get the color you want.

If you do not want to map colors to severity levels, select the None button.

5. Click OK.
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Monitoring Incoming Log Messages

To monitor log messages in real time:

1. Start the Message Browser:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Browser. Log Central displays the Message Browser.

2. Select Online Monitoring.

3. Click Start.

The Log Central Console monitors log messages in real time as they arrive at the 
Central Collector. The Message Browser displays messages that satisfy the filter 
settings you defined in the Filter Settings window, with the most recent message 
displayed at the top of the message pane. For information about the filter 
settings, see “Filtering Log Messages.”

Querying the Database

To query the Log Central database:

1. Start the Message Browser:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Browser. Log Central displays the Message Browser.

2. Select Historical Query.
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3. Click Start.

Queries the Log Central database. The Message Browser displays messages that 
satisfy the filter settings you defined in the Filter Settings window, with the most 
recent message displayed at the top of the message pane. For information about 
the filter settings, see “Filtering Log Messages.”

Filtering Log Messages

The Message Browser enables you to set filter criteria that:

n Define which real-time incoming messages to display during online monitoring

n Define which messages to retrieve in a database query

You can also set filters that the data collection agents use. For more information, see 
Chapter 7, “Creating Filters,” in the Log Central Configuration Guide.

To filter messages:

1. Start the Message Browser:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Browser. Log Central displays the Message Browser.
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2. Click Filter.

The Message Browser displays the Filter Settings window.

Figure 3-4   Filter Settings Window
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3. Select Online Monitoring or Historical Query.

The Filter Settings window displays the current filter settings for online 
monitoring or database queries. When you select Online Monitoring in the 
Message Browser and click Start, the Message Browser uses the online 
monitoring filter settings to display real-time incoming messages. When you 
select Historical Query in the Message Browser and click Start, the Message 
Browser uses the database query filter settings to retrieve and display messages 
that are in the Log Central database.

4. Select one of the Acknowledged Messages buttons:

l Yes—Display only acknowledged messages.

l No—Display only unacknowledged messages.

l All—Display acknowledged and unacknowledged messages.

5. If you are filtering a database query:

l Optionally, specify the first message by checking First Log Message and 
setting a date and time for the first message.

l Optionally, specify the last message by checking Last Log Message and 
setting a date and time for the last message.

6. If you are filtering a database query, optionally set the sort order based on 
message fields. 

You can configure up to three sorts, using ascending and descending sort order. 
To configure a sort:

l Select or deselect Ascending. If you deselect Ascending, the Log Central 
Console sorts the messages in descending order. Ascending or descending 
order is determined by the alphabetical or numerical values in the selected 
message field. If a message field can contain both alphabetical and numerical 
values, the numerical values come first when sorted in ascending order.

l Choose a message field in the Key drop-down list. Log Central sorts based 
on Key1 if it is set, then based on Key2 if it is set, and finally based on Key3 
if it is set. The result is one list. For example, if Key1 is Date and Key2 is 
Subsystem, Log Central sorts by date and then by subsystem. The resulting 
list is ordered by subsystem, with the messages for a given subsystem 
ordered by date.

7. Optionally, select the severity levels and log levels to include.
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8. Optionally, set filter criteria for the message fields:

a. Select the tab for a message field. (There is a tab for most of the message fields.)

Note: Even though the Filter Settings window displays the Trans Id tab, this tab 
is inactive because Transaction ID has been removed from the Log Central 
message format.

b. Decide which of the following types of filter criteria to use for this field:

Include messages that contain any values for this field (Show All).

Include messages that contain values in the Use Include List.

Exclude messages that contain values in the Use Exclude List.

In the example in the preceding figure, Log Central excludes messages for 
which the Subsystem value is EM, GP, LM, or ORACLE.

c. If you decided to use the Use Include List or Use Exclude List:

To move values from one list to the other, highlight the values and click the 
appropriate Selected button (Selected < or Selected >).

To move all values from one list to the other, click the appropriate All button 
(All < or All >).

To delete values from a list, select the values and click Del Selected. To 
delete all values in both lists, click Delete All.

To add a new value to a list, select the Use Include List or the Use Exclude 
List, enter the value in the text field above the buttons, and press Enter.

d. Select the Show All, Use Include List, or Use Exclude List button depending 
on the type of filter criteria you are using.

e. Repeat steps a through d for other tabs (fields) as desired.

9. Click OK.

The Log Central Console preserves these message definition editor filter settings 
until the next time that you modify them as long as you keep the Log Central 
Console running. Filter settings are lost when you exit the Log Central Console.
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Deleting Log Messages

To delete messages from the Log Central database:

1. Start the Message Browser:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Browser. Log Central displays the Message Browser.

2. Select Online Monitoring or Historical Query.

3. Click Start.

If you selected Online Monitoring, the Log Central Console monitors log 
messages in real time as they arrive at the Central Collector. If you selected 
Historical Query, the Log Central Console queries the Log Central database.

The Message Browser displays messages that satisfy the filter settings you 
defined in the Filter Settings window, with the most recent message displayed at 
the top of the message pane. For information about the filter settings, see 
“Filtering Log Messages.”

4. Click Stop.

5. If you are not going to delete all messages, select the messages to delete.

Note: The option to delete all messages is available only for historical queries. It 
is not available for real-time incoming messages.

6. From the Edit menu, choose Delete.

A submenu lets you delete the selected messages or all messages that were 
returned in the last database query.
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Acknowledging Log Messages

Message acknowledgment is a feature that you can use to keep track of system 
problems that are currently being resolved or actively investigated. The Message 
Browser displays each message’s acknowledgment status (Yes or No) in the Acked 
column in the Message pane. When you view the messages, you can see which ones 
are being worked on and which ones are not being handled yet.

To acknowledge messages:

1. Start the Message Browser:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Browser. Log Central displays the Message Browser.

2. Select Online Monitoring or Historical Query.

3. Click Start.

If you selected Online Monitoring, the Log Central Console monitors log 
messages in real time as they arrive at the Central Collector. If you selected 
Historical Query, the Log Central Console queries the Log Central database.

The Message Browser displays messages that satisfy the filter settings you 
defined in the Filter Settings window, with the most recent message displayed at 
the top of the message pane. For information about the filter settings, see 
“Filtering Log Messages.”

4. Click Stop.

5. If you are not going to acknowledge all messages, select the messages to 
acknowledge.

Note: The option to acknowledge all messages is available only for historical 
queries. It is not available for real-time incoming messages.
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6. From the Actions menu, choose Acknowledge.

A submenu lets you acknowledge the selected messages or all messages that 
were returned in the last database query.

Removing Acknowledgments

You might want to remove an acknowledgment if a message was acknowledged when 
it should not have been, or if a problem that was thought to be resolved is still 
occurring. 

To remove message acknowledgments:

1. Start the Message Browser:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Browser. Log Central displays the Message Browser.

2. Select Online Monitoring or Historical Query.

3. Click Start.

If you selected Online Monitoring, the Log Central Console monitors log 
messages in real time as they arrive at the Central Collector. If you selected 
Historical Query, the Log Central Console queries the Log Central database.

The Message Browser displays messages that satisfy the filter settings you 
defined in the Filter Settings window, with the most recent message displayed at 
the top of the message pane. For information about the filter settings, see 
“Filtering Log Messages.”

4. Click Stop.

5. If you are not going to remove acknowledgments for all messages, select the 
desired messages.
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Note: The option to remove acknowledgments for all messages is available only 
for historical queries. It is not available for real-time incoming messages.

6. From the Actions menu, choose Clear Acknowledgment.

A submenu lets you remove the acknowledgments from the selected messages or 
all messages that were returned in the last database query.

Viewing Log Message Definitions

To view the message definition fields associated with a message:

1. Start the Message Browser:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Browser. Log Central displays the Message Browser.

2. Select Online Monitoring or Historical Query.

3. Click Start.

If you selected Online Monitoring, the Log Central Console monitors log 
messages in real time as they arrive at the Central Collector. If you selected 
Historical Query, the Log Central Console queries the Log Central database.

The Message Browser displays messages that satisfy the filter settings you 
defined in the Filter Settings window, with the most recent message displayed at 
the top of the message pane. For information about the filter settings, see 
“Filtering Log Messages.”

4. Click Stop.

5. Select a message.
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6. From the View menu, choose Message Details.

The Message Browser displays the Message Details window. This window 
displays the message body and the message definition fields.

To change a message definition, see Chapter 4, “Changing Message Definitions and 
Subsystem Descriptions.”
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CHAPTER
4 Changing Message 
Definitions and 
Subsystem 
Descriptions

A message definition provides static information about log messages, such as 
recommendations for responding to errors. The Central Collector appends a message 
definition to each log message based on the message ID and subsystem values in the 
message.

The following sections describe the functions of the Message Definition Editor:

n Working with the Message Definition Editor

n Displaying Message Definitions

n Filtering Message Definitions

n Adding a Message Definition

n Changing a Message Definition

n Deleting Message Definitions

n Changing a Subsystem Description

For more information about message definitions, see Chapter 6, “Creating Message 
Definitions,” in the Log Central Configuration Guide.
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Working with the Message Definition Editor

The following sections explain how to use the Message Definition Editor:

n Starting the Message Definition Editor

n Main Components of the Message Definition Editor

n Message Definition Editor Toolbar

n Message Definition Editor Menus

n Changing the Message Definition Layout

n Working with the Message Definition Details File Menu

Starting the Message Definition Editor

To start the Message Definition Editor:

1. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, “Introducing 
the Log Central Console.” For the lc_launch command syntax, see 
Appendix B, “Commands.”
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2. Click Msg Def Edit. Log Central displays the Message Definition Editor.

Figure 4-1   Message Definition Editor

Main Components of the Message Definition Editor

The following table describes the main components of the Message Definition Editor.
 

Table 4-1  Main Components of the Message Definition Editor

Component Description

Menu bar Provides the menus for the Message Definition Editor. For more information, see 
“Message Definition Editor Menus.”

Toolbar Provides access to frequently used actions. For more information, see “Message 
Definition Editor Toolbar.”
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Message Definition Editor Toolbar

The following table describes the Message Definition Editor toolbar.

Displayed/Matched field When you query the database, this field displays the number of message definitions 
that satisfy the message definition filter settings and the number of message 
definitions displayed. These numbers differ if the query found more message 
definitions than the maximum that can be displayed. To configure the maximum 
number of message definitions that can be displayed, use the -n option when you 
start the Log Central Console. 

For information about message definition filter settings, see “Filtering Message 
Definitions.” For information about the -n option, see the description of the 
lc_launch command in Appendix B, “Commands.”

Message definition pane Displays message definitions.

Table 4-1  Main Components of the Message Definition Editor

Component Description

Table 4-2  Message Definition Editor Toolbar

Button Action

Retrieves and displays message definitions from messages that are in the Log Central 
database. The Message Definition Editor displays message definitions that satisfy the 
message definition filter settings, with the most recent message definitions displayed at 
the top of the message definition pane. For information about the message definition 
filter settings, see “Filtering Message Definitions.”

Stops retrieval of message definitions. This button is inactive if message definitions are 
not being retrieved.

Displays the Message Definition Editor Layout window, in which you specify the 
message definition fields to display and the order in which to display them. For 
information about using the Message Definition Editor Layout window, see “Changing 
the Message Definition Layout.” You can also use the Layout Definition command in 
the Settings menu to display the Message Definition Editor Layout window.
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Displays the Message Definition Editor Filter Settings window, in which you can:

n Define the criteria for determining which message definitions to display in the 
message definition pane

n Select the sort order for message definitions from a database query

For information about using the Message Definition Editor Filter Settings window, see 
“Filtering Message Definitions.” You can also use the Editor Filter Settings command in 
the Settings menu to display the Message Definition Editor Filter Settings window.

Displays the Message Colors window, in which you can change the colors for the 
severity levels. For information about using the Color Settings window, see “Changing 
Severity Colors” in Chapter 3, “Managing Log Messages.” You can also use the 
Message Colors command in the Settings menu to display the Message Colors window.

Displays the Log Central Online Help. You can also use the commands in the Help menu 
to display the Log Central Online Help.

Table 4-2  Message Definition Editor Toolbar

Button Action
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Message Definition Editor Menus

The following table describes the Message Definition Editor menus.

Table 4-3  Message Definition Editor Menus

Menu Commands

File New Message Definition—Displays the Message Definition Details window with blank 
fields in which you can enter a new message definition. You can also enter a new message 
definition by selecting the Message Definition command from the Edit menu (which 
displays the Message Definition Details window) and then selecting New from the File 
menu.

Reports—Generates a report of the message definitions retrieved from a database query. 
This option is inactive if the Message Definition Editor is processing a query. A submenu 
enables you to generate a summary report or a detail report. A summary report groups 
message definitions by subsystem and presents the message definition totals for each 
severity level and log level. A detail report provides most of the message definition fields 
for each message. For more information about generating reports, see Chapter 5, 
“Generating Reports.”

Close—Exits the Message Definition Editor.

Edit Message Definition—Displays the Message Definition Details window in which you can 
edit the selected message definition. For more information, see “Working with the Message 
Definition Details File Menu.”

Subsystem Description—Displays the Subsystem Definition window in which you can edit 
the description for a subsystem that has an entry in the Log Central database.

Delete—Displays a submenu that allows you to delete selected message definitions or all 
the message definitions.
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Settings Editor Filter Settings—Displays the Message Definition Editor Filter Settings window in 
which you can:

n Define the criteria for determining which message definitions to display in the message 
definition pane

n Select the sort order for message definitions from a database query

For information about using the Message Definition Editor Filter Settings window, see 
“Filtering Message Definitions.” You can also use the Filter button in the toolbar to display 
the Message Definition Editor Filter Settings window.

Layout Definition—Displays the Message Definition Editor Layout window, which lets 
you specify the message definition fields to display and the order in which to display them. 
For information about using the Message Definition Editor Layout window, see “Changing 
the Message Definition Layout.” You can also use the Layout button in the toolbar to 
display the Message Definition Editor Layout window.

Message Colors—Displays the Message Colors window, which lets you change the colors 
for the severity levels. For information about using the Color Settings window, see 
“Changing Severity Colors” in Chapter 3, “Managing Log Messages.” You can also use the 
Colors button in the toolbar to display the Message Colors window.

Actions This menu works only for database queries, not for online monitoring.

Start—Starts a database query.

Stop—Stops the database query.

Help Displays the Log Central Online Help for various Message Definition Editor help topics. 
You can also use the Help button in the toolbar to display the Log Central Online Help.

Table 4-3  Message Definition Editor Menus

Menu Commands
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Changing the Message Definition Layout

You can change the fields to display in the Message Definition Editor’s message 
definition pane. You can also change the order in which the fields are displayed. 

To change the message definition layout:

1. Start the Message Definition Editor:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Def Edit. Log Central displays the Message Definition Editor.
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2. Click Layout.

The Message Definition Editor displays the Message Definition Editor Layout 
window.

Figure 4-2   Message Definition Editor Layout Window

3. Select the fields to show or hide. 

Use the Show and Hide buttons to move selections from one list to the other.

4. Use the up and down arrows to change the order in the Show list.

5. Click OK.
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Working with the Message Definition Details File Menu

The following table describes the Message Definition Details File menu.

Displaying Message Definitions

To display message definitions:

1. Start the Message Definition Editor:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Def Edit. Log Central displays the Message Definition Editor.

Table 4-4  Message Definition Details File Menu

Command Description

View to Window Displays the message definition in a separate window. You can then copy the 
window content to a file.

New Displays a new Message Definition Details window with blank fields in which you 
can define a new message definition. You can also enter a new message definition 
by displaying the Message Definition Editor and then selecting New Message 
Definition from the File menu.

Save Saves your changes.

Delete Deletes the message definition. Alternatively, you can delete message definitions 
by displaying the Message Definition Editor and then selecting Delete from the Edit 
menu.

Close Closes the Message Definition Details window.
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2. Click Start.

The Message Definition Editor displays message definitions that satisfy the 
message definition filter settings you defined in the Message Definition Filter 
Settings window, with the most recent message definition displayed at the top of 
the message definition pane. For information about the message definition filter 
settings, see “Filtering Message Definitions.”

Filtering Message Definitions

Use the Message Definition Editor to specify filter criteria that define which message 
definitions to display. 

To filter message definitions:

1. Start the Message Definition Editor:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Def Edit. Log Central displays the Message Definition Editor.
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2. Click Filter.

The Message Definition Editor displays the Message Definition Editor Filter 
Settings window.

Figure 4-3   Message Definition Editor Filter Settings Window
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3. Optionally, select the severity levels to include.

4. Select one of the Auto Acknowledge Flag buttons:

l Yes—Display only message definitions in which Auto Acknowledge is YES.

l No—Display only message definitions in which Auto Acknowledge is NO.

l All—Display message definitions with either value for Auto Acknowledge.

5. Optionally, set the sort order based on message definition fields. 

You can configure up to three sorts, using ascending and descending sort order. 
To configure a sort:

l Select or deselect Ascending. If you deselect Ascending, the Log Central 
Console sorts the messages in descending order. Ascending or descending 
order is determined by the alphabetical or numerical values in the selected 
message field.

l Choose a message definition field in the Key drop-down list. Log Central 
sorts based on Key1 if it is set, then based on Key2 if it is set, and finally 
based on Key3 if it is set. The result is one list. For example, if Key1 is 
Summary and Key2 is Severity, Log Central sorts by summary and then by 
severity. The resulting list is ordered by severity, with the messages for a 
given severity ordered by summary.

6. Optionally, set filter criteria for the Subsystem and Message ID fields:

a. Select the Subsystem or Message ID tab.

b. Decide which of the following types of filter criteria to use for this field:

Include message definitions that contain any values for this field (Show All).

Include message definitions that contain values in the Use Include List.

Exclude message definitions that contain values in the Use Exclude List.

In the example in the preceding figure, Log Central excludes message 
definitions for which the Subsystem value is WEBGUI, VUFORM, or 
TxRPC.

c. If you decided to use the Use Include List or Use Exclude List:

To move values from one list to the other, highlight the values and click the 
appropriate Selected button (Selected < or Selected >).
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To move all values from one list to the other, click the appropriate All button 
(All < or All >).

To delete values from a list, select the values and click Del Selected. To 
delete all values in both lists, click Delete All.

To add a new value to a list, select the Use Include List or the Use Exclude 
List, enter the value in the text field above the buttons, and press Enter.

d. Select the Show All, Use Include List, or Use Exclude List button depending 
on the type of filter criteria you are using.

e. Optionally, repeat steps a through d for other tab.

7. Click OK.

The Log Central Console preserves these Message Definition Editor filter 
settings until the next time that you modify them as long as you keep the Log 
Central Console running. Filter settings are lost when you exit the Log Central 
Console.

Adding a Message Definition

This procedure explains how to add one message definition. To add multiple message 
definitions at one time, create a message definition file and run msgdef_import. For 
information about message definition files, see Chapter 6, “Creating Message 
Definitions,” in the Log Central Configuration Guide. For the msgdef_import 
command syntax, see Appendix B, “Commands.”

To add a message definition:

1. Start the Message Definition Editor:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Def Edit. Log Central displays the Message Definition Editor.
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2. From the File menu, choose New Message Definition.

The Message Definition Editor displays the Message Definition Details window.

Figure 4-4   Message Definition Details Window
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3. Enter values in the fields.

For a description of the message definition fields, see Appendix A, “Log Central 
Message and Message Definition Formats.”

For information about the File menu in the Message Definition Details window, 
see “Working with the Message Definition Details File Menu.”

4. Click Add.

Changing a Message Definition

To modify a message definition:

1. Start the Message Definition Editor:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Def Edit. Log Central displays the Message Definition Editor.
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Changing a Message Definition
2. Double-click on the message definition to modify.

The Message Definition Editor displays the Message Definition Details window.

Figure 4-5   Message Definition Details Window
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3. Modify the values. 

For a description of the message definition fields, see Appendix A, “Log Central 
Message and Message Definition Formats.”

For information about the File menu in the Message Definition Details window, 
see the earlier section “Working with the Message Definition Details File 
Menu.”

4. Click Save.

Deleting Message Definitions

To delete message definitions:

1. Start the Message Definition Editor:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Def Edit. Log Central displays the Message Definition Editor.

2. If you are not going to delete all message definitions, select the message 
definitions to delete.

3. From the Edit menu, choose Delete.

A submenu lets you delete the selected message definitions or all message 
definitions.
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Changing a Subsystem Description
Changing a Subsystem Description

Note: You create a subsystem description when you use the subsystem_create 
command to create a subsystem. You delete a subsystem description when you 
use the subsystem_delete command to delete a subsystem. For information 
about these commands, see Appendix B, “Commands.”

To change a subsystem description:

1. Start the Message Definition Editor:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Msg Def Edit. Log Central displays the Message Definition Editor.
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2. From the Edit menu, choose Subsystem Definition.

The Message Definition Editor displays the Subsystem Definition window.

Figure 4-6   Subsystem Definition Window

3. Select the subsystem to change.

4. Enter the new description in the Description field.

5. To save the change, select the green checkmark. To undo the change, select the 
red X.

6. Click Close.
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CHAPTER
5 Generating Reports

The following sections explain how to generate reports:

n Generating a Message Report

n Generating a Message Definition Report

Generating a Message Report

To generate a message report:

1. Set the message filtering criteria. For information, see “Filtering Log Messages” in 
Chapter 3, “Managing Log Messages.”

2. Query the database. For information, see “Querying the Database” in Chapter 3, 
“Managing Log Messages.”

3. From the File menu, choose Reports.

A submenu lets you generate a summary report or a detail report:

l Summary report—groups messages by subsystem and presents the message 
totals for each severity level and log level. 

l Detail report—provides most of the message fields for each message.

The generated report is an HTML file that Log Central creates in 
install_dir/web/applet, where install_dir is the directory where you installed 
Log Central. To view this file, you need a Web browser that the Log Central Console 
can access. To specify a Web browser, use the -b option when you start the Log 
Central Console. For more information, see the description of the lc_launch 
command in Appendix B, “Commands.”
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Generating a Message Definition Report

To generate a message definition report:

1. Set the message definition filtering criteria. For information, see “Filtering 
Message Definitions” in Chapter 4, “Changing Message Definitions and 
Subsystem Descriptions.”

2. Click Start.

3. From the File menu, choose Reports.

A submenu lets you generate a summary report or a detail report:

l Summary report—groups message definitions by subsystem and presents the 
message definition totals for each severity level and log level. 

l Detail report—provides most of the fields for each message definitions.

The generated report is an HTML file that Log Central creates in 
install_dir/web/applet, where install_dir is the directory where you installed 
Log Central. To view this file, you need a Web browser that the Log Central Console 
can access. To specify a Web browser, use the -b option when you start the Log 
Central Console. For more information, see the description of the lc_launch 
command in Appendix B, “Commands.”
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CHAPTER
6 Configuring SNMP 
Traps

You use the Basic Trap Configuration tool in the Log Central Console to configure 
basic SNMP traps, which are generated by the Central Collector. For information 
about SNMP traps and to set up SNMP management, see Chapter 8, “Integrating 
SNMP,” in the Log Central Configuration Guide. To configure advanced traps, see 
Chapter 7, “Creating Filters,” in the Log Central Configuration Guide.

To configure a basic SNMP trap:

1. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, “Introducing 
the Log Central Console.” For the lc_launch command syntax, see 
Appendix B, “Commands.”
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2. Click Basic Trap.

The Log Central Console displays the Basic Trap Configuration tool.

Figure 6-1   Basic Trap Configuration Tool

3. Select the Trap Generation tab.

4. Select Message Definition or Severity or both.

If you enable trap generation based on message definition, the Central Collector 
generates a trap for an incoming message if the Trap Enabled field in the 
associated message definition is YES. The Trap ID in the message definition 
specifies the trap number that is generated. For descriptions of the Trap Enabled 
and Trap ID fields, see Appendix A, “Log Central Message and Message 
Definition Formats.”

If you enable trap generation based on severity, the Central Collector generates a 
trap for an incoming message if the message meets the trap configuration criteria 
as described in the next step.
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5. If you enabled traps based on severity:

a. Select the Trap Configuration tab.

Figure 6-2   Trap Configuration Tab

b. Select which severities will generate traps.

c. If traps are not also enabled based on message definitions, enter a trap number 
for each selected severity in the ID of Resulting Trap field.

By default, the Trap Configuration tab displays the trap IDs described in 
Appendix C, “SNMP Traps.” You can change these values in the tab.

Note: If you enabled traps based on message definitions, the Central Collector 
uses the message definition’s Trap ID field as the trap number even if the 
trap is generated based on severity.

6. Click OK.
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CHAPTER
7 Managing the 
Database and 
Intermediate Files

The following sections describe how to manage the Log Central database and the 
Central Collector intermediate files:

n Working with the Storage Maintenance Tool

n Deleting Database Records

n Deleting Intermediate Files

n Creating a Processing Script

n Processing Records on a One-Time Basis

n Processing Records and Files on a Schedule
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Working with the Storage Maintenance Tool

The Storage Maintenance tool enables you to delete and to execute processing scripts 
for database records and intermediate files.

The following sections explain how to use the Storage Maintenance tool:

n Starting the Storage Maintenance Tool

n Main Components of the Storage Maintenance Tool

n Storage Maintenance Tool Toolbar

n Storage Maintenance Tool Menus

Starting the Storage Maintenance Tool

To start the Storage Maintenance tool:

1. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, “Introducing 
the Log Central Console.” For the lc_launch command syntax, see 
Appendix B, “Commands.”
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Working with the Storage Maintenance Tool
2. Click Storage Maint. Log Central displays the Storage Maintenance tool.

Figure 7-1   Storage Maintenance Tool
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Main Components of the Storage Maintenance Tool

The following table describes the main components of the Storage Maintenance tool.
 

Storage Maintenance Tool Toolbar

The following table describes the Storage Maintenance tool toolbar.

Table 7-1  Main Components of the Storage Maintenance Tool

Component Description

Menu bar Provides the menus for the Storage Maintenance tool. For more information, see “Storage 
Maintenance Tool Menus.”

Toolbar Provides access to frequently used actions. For more information, see “Storage Maintenance 
Tool Toolbar.”

Message Tabs The Messages in Database tab displays the number of messages delivered to the database 
during each hour of the day. The Intermediate Message Files tab displays the names of the 
Central Collector’s intermediate files.

Table 7-2  Storage Maintenance Tool Toolbar

Button Action

Displays the Operations Settings window. This window enables you to:

n Delete database records. See “Deleting Database Records.”

n Delete intermediate files. “Deleting Intermediate Files.”

n Configure a schedule for processing database records and intermediate files. 
“Processing Records and Files on a Schedule.”

You can also use the Operations command in the Settings menu to display the Operations 
Settings window.

Refreshes the display to show the current database records and intermediate files.
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Storage Maintenance Tool Menus

The following table describes the Message Browser menus.

Displays the Log Central Online Help. You can also use the commands in the Help menu 
to display the Log Central Online Help.

Table 7-2  Storage Maintenance Tool Toolbar

Button Action

Table 7-3  Storage Maintenance Tool Menus

Menu Commands

File Process Records—Executes the process_dbrec script for the selected database records. 
This command is available only if the Messages in Database tab is selected. For more 
information about process_dbrec, see “Creating a Processing Script.”

Delete—Deletes the selected database records and intermediate files. You can delete an 
intermediate file only after all the associated messages have been uploaded to the Log 
Central database.

Close—Exits the Storage Maintenance tool.

Settings Operations—Displays the Operations Settings window. This window enables you to:

n Delete database records. See “Deleting Database Records.”

n Delete intermediate files. See “Deleting Intermediate Files.”

n Configure a schedule for processing database records and intermediate files. See 
“Processing Records and Files on a Schedule.”

You can also use the Settings button in the toolbar to display the Operations Settings 
window.

Help Displays the Log Central Online Help for various Storage Maintenance tool help topics. 
You can also use the Help button in the toolbar to display the Log Central Online Help.
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Deleting Database Records

To schedule the deletion of database records:

1. Start the Storage Maintenance tool:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Storage Maint. Log Central displays the Storage Maintenance tool.
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Deleting Database Records
2. Click Settings.

The Storage Maintenance tool displays the Operations Settings window.

Figure 7-2   Operations Settings Window

3. Select the Messages in Database tab.

4. Select the Delete Records checkbox.

5. Set the start time for the deletion.

6. Specify how often to repeat the deletion. 

To perform the deletion only once, deselect the Repeat Every checkbox.
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7. Specify which records to delete.

You can instruct Log Central to delete records based on age or based on a range 
of dates.

8. Click OK.

Deleting Intermediate Files

Log Central deletes intermediate files only after all their messages have been stored in 
the database.

To schedule the deletion of intermediate files:

1. Start the Storage Maintenance tool:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Storage Maint. Log Central displays the Storage Maintenance tool.
7-8 Log Central Online Help



Deleting Intermediate Files
2. Click Settings.

The Storage Maintenance tool displays the Operations Settings window.

Figure 7-3   Operations Settings Window

3. Select the Intermediate Message Files tab.

4. Set the start time for the deletion.

5. Specify how often to repeat the deletion. 

6. Set the age of the files to delete.

7. Click OK.
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Creating a Processing Script

Log Central can execute a script on its intermediate files and on messages in the 
database. Log Central provides the process_dbrec script as a sample file. The file is 
a shell script on UNIX machines or a batch file on Windows NT. The file includes 
comments that describe how to use it. The script does not do anything as shipped. The 
Storage Maintenance tool lets you specify how frequently to run the script. You can 
also run the script one time by using the Process Records command in the File menu. 
See “Processing Records on a One-Time Basis.”

Some of the things you can modify the script to do include:

n Generating an email message that lists which messages were deleted and the 
date and time of the deletion

n Copying the archive file to a tape

n Using an SQL statement to move records to a different table in the Log Central 
database

The script uses the following syntax:

process_dbrec starttime endtime

The following table describes the input arguments.

Your script can use these arguments as needed. To set these arguments, set the From 
and To fields in the Message in Database tab in the Operations Settings window.

Do not put any commands in the script, such as echo, that write to the standard output 
terminal. The standard output terminal is not available in this context.

Table 7-4  Input Arguments for process_dbrec

Argument Description

starttime The time to start running the script. A value of 0 specifies 
to process all records before endtime.

endtime The time to quit running the script.
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Processing Records on a One-Time Basis
Log Central expects the script to return -1 if there is an error or 0 it if runs successfully. 
Records are deleted only after the script runs successfully, even if you selected the 
Delete Records option.

To create a processing script:

1. With a text editor, open the file install_dir/bin/process_dbrec.bat (NT) or 
install_dir/bin/process_dbrec (UNIX), where install_dir is the 
directory where you installed Log Central.

2. Modify the script.

3. Save the script.

Processing Records on a One-Time Basis

You can run the processing script on selected database records on a “one shot” basis. 
This operation is not valid for intermediate files. 

To run the processing script one time:

1. Create a processing script as described in “Creating a Processing Script.”

2. Start the Storage Maintenance tool:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Storage Maint. Log Central displays the Storage Maintenance tool.

3. Select the Messages in Database tab.
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Figure 7-4   Messages in Database Tab

4. Select the records to process.

5. From the File menu, choose Process Records.
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Processing Records and Files on a Schedule
Processing Records and Files on a Schedule

To schedule the processing script:

1. Create a processing script as described in “Creating a Processing Script.”

2. Start the Storage Maintenance tool:

a. Start the Log Central Console by running lc_launch on the central host. 

For detailed information about starting the Console, see Chapter 2, 
“Introducing the Log Central Console.” For the lc_launch command 
syntax, see Appendix B, “Commands.”

b. Click Storage Maint. Log Central displays the Storage Maintenance tool.
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3. Click Settings.

The Storage Maintenance tool displays the Operations Settings window.

Figure 7-5   Operations Settings Window

4. Select the Messages in Database tab.

5. Select the Process Records checkbox.

6. Optionally, select the Delete Records checkbox.

Log Central will delete database records after running the script. Log Central 
deletes intermediate files only after all their messages have been stored in the 
database.

7. Set the start time for the script.
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Processing Records and Files on a Schedule
8. Specify how often to run the script. 

To run the script only once, deselect the Repeat Every checkbox.

9. Specify which records to run the script on.

You can tell Log Central to run the script on records based on age or based on a 
range of dates.

10. Click OK.
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CHAPTER
8 Testing and Debugging

Use the following commands to test and debug Log Central:

n msg_test, which generates test messages.

n msg_reader, which displays the current intermediate log file.

n show_config, which checks the syntax of the messaging configuration file or 
displays information about Log Central.

For more information about these commands, see Appendix B, “Commands.”
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APPENDIX
A Log Central Message 
and Message 
Definition Formats

A Log Central message consists of a message header and a message body. A message 
definition is associated with a message based on the message ID and subsystem values 
in the message header. The following sections provide detailed descriptions of the Log 
Central message and message definition formats:

n Example of a Log Central Message and Message Definition

n Message Header
l Log ID
l Logging Level
l Date and Time
l Subsystem
l Message ID
l Host
l Process ID
l User ID
l Function
l Entity

n Message Body

n Message Definition
l Summary
l Severity
l Description
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l Recommendation
l Execute on Upload
l Trap ID
l Trap Enabled
l Auto Acknowledge

For information about how Log Central constructs a log message, see “Construction of 
Log Messages” in Chapter 1, “Overview.”

Example of a Log Central Message and 
Message Definition

The following figure shows the fields that are in a Log Central message.

Figure A-1   Log Central Message Fields
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Message Header
The following figure shows the fields that are in a Log Central message definition.

Figure A-2   Log Central Message Definition Fields

Message Header

The following sections describe the fields in a message header:

n Log ID

n Logging Level

n Date and Time

n Subsystem

n Message ID

n Host

n Process ID

n User ID

n Function

n Entity

For more information about message headers, see “IL_SM_LOG_TABLE: Message 
Header” in Appendix E, “Database Schema,” in the Log Central Configuration Guide.
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Log ID

Logging Level

Description: Value that distinguishes one set of log messages from 
another, which lets logically separate log information be 
stored in one database. For example, the log IDs IRX and 
DCS might distinguish messages logged by a drug claim 
system from those logged by a document control system.

Format: String

Size: Up to 3 characters

Optional?: Optional

Corresponding Field: In the IL_SM_LOG_TABLE database table: 
MSG_LOG_ID

Description: Logging level

Format: Character

Size: 1 character

Range: Possible values:

n N = Normal message

n D = Debug message

n V = Verbose message

n S = Special message

Optional?: Not optional

Corresponding Field: In the IL_SM_LOG_TABLE database table: 
MSG_REP_MODE
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Message Header
Date and Time

Subsystem

Description: Month, day, hour, minute, second, and year on the machine 
that generated the message.

Format: Mmm dd hh:mm:ss yyyy

Optional?: Not optional

Corresponding Field: In the IL_SM_LOG_TABLE database table: 
MSG_KEY_TS

Description: Subsystem that generated the message. The 
subsystem_create and subsystem_delete commands, 
which are described in Appendix B, “Commands,” let you 
add and delete subsystems.

Format: String

Size: Up to 8 characters

Optional?: Not optional. In a message definition file, this field must be 
in the first definition, and is optional for the succeeding 
definitions.

Corresponding Field: In the IL_SM_LOG_TABLE database table: 
MSG_SS_NAME
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Message ID

Host

Description: Identifies the type of message within a subsystem. 
Together, the Subsystem and Message ID uniquely identify 
a message. 

Format: Integer

Range: 1 through 99999

The convention for message ID values is:

n 1 through 49999 = Activity and error messages 
defined by application developers

n 50000 through 89999 = Reserved for future use

n 90000 = Startup message

n 90001 = Shutdown message

n 90002 = Transaction processing message

n 90100 = Transaction processing message (NCPDP)

n 90201 through 99999 = Reserved for future use

Optional?: Not optional

Corresponding Field: In the IL_SM_LOG_TABLE database table: MSG_ID

Description: Network host for the system that generated the message. 
This value can include dots, underscores, and dashes.

Format: String

Size: Up to 64 characters
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Message Header
Process ID

User ID

Optional?: Not optional

Corresponding Field: In the IL_SM_LOG_TABLE database table: 
MSG_HOST_NAME

Description: PID of the process that generated the message.

Format: Integer

Range: 1 through 99999

Optional?: Not optional

Corresponding Field: In the IL_SM_LOG_TABLE database table: MSG_PID

Description: User ID of the process that generated the message.

Format: String

Size: Up to 8 characters

Optional?: Not optional

Corresponding Field: In the IL_SM_LOG_TABLE database table: MSG_UID
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Function

Entity

Description: Internal function that generated the message. The 
convention for function values is:

n Function name if logged by a library function

n Process name if logged by a main process function

Format: String

Size: Up to 40 characters

Optional?: Optional

Corresponding Field: In the IL_SM_LOG_TABLE database table: 
MSG_FCT_NAME

Description: Value that helps correlate a message with messages from 
other managed nodes. You can use this value to define a 
domain. The domain can be a Tuxedo domain or WebLogic 
Enterprise domain, but is not required to be one of these 
types of domains. The default value is “None.”

For example, if a system has three managed nodes and each 
managed node has a Log Monitor with an entity name of 
LogMonWLE, these Log Monitors constitute a domain. 

For another example, if you have a Tuxedo domain for sales 
information, you can set the entity name to “Sales” for each 
Log Monitor in the domain.

For information about setting and using the entity value, see 
Chapter 7, “Creating Filters,” and the section 
“DEFINE_LOG_MONITOR” in Appendix G, 
“Configuration Files.”
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Message Body
Message Body

Message Definition

The following sections describe the fields in a message definition:

n Summary

n Severity

n Description

n Recommendation

n Execute on Upload

n Trap ID

Format: String

Size: Up to 21 characters

Optional?: Optional

Corresponding Field: In the IL_SM_LOG_TABLE database table: 
MSG_TRAN_KEY

Description: Text determined by the application developer.

Format: String

Size: Up to 2000 characters

Optional?: Not optional

Corresponding Field: In the IL_SM_LOG_TABLE database table: MSG_TEXT
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n Trap Enabled

n Auto Acknowledge

For more information about message definitions, see:

n Chapter 6, “Creating Message Definitions,” in the Log Central Configuration 
Guide.

n “IL_MSG: Message Definition” in Appendix E, “Database Schema,” in the Log 
Central Configuration Guide.

n Chapter 4, “Changing Message Definitions and Subsystem Descriptions.”

Summary

Description: Summary of the “Description” field which describes the 
condition or event that the message is reporting.

Format: String

Size: Up to 40 characters

Optional?: Not optional

Corresponding Fields: In a message definition file: SUMMARY

In the IL_MSG database table: LOG_SDESC
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Message Definition
Severity

Description

Description: Possible values: 

n Informational = Activity message. 

n Warning = Problem that does not need immediate 
attention.

n Minor = Performance or service degradation may 
result.

n Major = Problem that needs immediate attention, or 
the system performance may deteriorate. 

n Critical = Problem that need immediate attention, or 
the system may crash.

Format: String

Size: N/A

Optional?: Not optional. In a message definition file, this field must be 
in the first definition, and is optional for the succeeding 
definitions.

Corresponding Fields: In a message definition file: SEVERITY 

In the IL_MSG database table: LOG_MSG_SEVERITY

Description: Description of the condition or event that the message is 
reporting.

Format: String

Size: With the Recommendation field, up to 2 Gb.
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Recommendation

Execute on Upload

Optional?: Optional

Corresponding Fields: In a message definition file: DESCRIPTION 

In the IL_MSG database table: LOG_MSG_DESC_REC

Description: Recommended action for handling the message.

Format: String

Size: With the Description field, up to 2 Gb.

Optional?: Optional

Corresponding Fields: In a message definition file: RECOMMENDATAION 

In the IL_MSG database table: LOG_MSG_DESC_REC

Description: Path to a script or executable file that the Central Collector 
runs when it stores the message in the Log Central database.

Format: String

Size: Up to 40 characters

Optional?: Optional

Corresponding Fields: In a message definition file: EXECUTE_ON_UPLOAD 

In the IL_MSG database table: LOG_MSG_PARSE_FNC
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Trap ID

Trap Enabled

Description: Basic SNMP trap to generate for the message. For 
information about generating basic SNMP traps, see 
“Configuring SNMP Traps” in the Log Central Online 
Help.

Format: Integer

Range: 1 through 99999

Optional?: Optional

Corresponding Fields: In a message definition file: TRAP_ID 

In the IL_MSG database table: LOG_MSG_TRAP_ID

Description: Flag that indicates whether or not to generate a basic SNMP 
trap for the message. For information about generating basic 
SNMP traps, see “Configuring SNMP Traps” in the Log 
Central Online Help.

Format: String

Range: YES 

NO (default)

Optional?: Optional

Corresponding Fields: In a message definition file: TRAP_ENABLED 

In the IL_MSG database table: 
LOG_MSG_TRAP_ENABLED
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Auto Acknowledge

Description: Flag that indicates whether or not to automatically 
acknowledge the message. One reason to acknowledge 
messages is to keep track of the system problems that are 
currently being resolved or actively investigated.

Format: String

Range: YES 

NO (default)

Optional?: Optional

Corresponding Fields: In a message definition file: AUTO_ACKNOWLEDGE 

In the IL_MSG database table: LOG_MSG_AUTO_ACK
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APPENDIX
B Commands

The following table provides an overview of the Log Central commands. The rest of 
this appendix describes each command in detail.

Table B-1  Commands

Command Description

lc_config Runs the Host Configuration utility

lc_create_schema Creates a database schema

lc_drop_schema Drops a database schema

lc_launch Starts the Log Central Console

lc_user_create Creates a user in the database

lc_user_delete Deletes a user from the database

lc_user_modify Changes a user’s password in the database

lc_user_list Lists all the users in the database

log_monitor Starts a Log Monitor

msgdef_delete Deletes message definitions from the database

msgdef_export Copies message definitions from the database to a text file

msgdef_import Loads a message definition file into the database

msg_reader Displays the current intermediate log file

msg_test Generates test messages
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lc_config

show_config Checks the syntax of the messaging configuration file or displays information about 
Log Central

start_messaging Starts the Log Central processes

stop_messaging Stops the Log Central processes

subsystem_create Creates a subsystem in the database

subsystem_delete Deletes a subsystem from the database

Table B-1  Commands

Command Description

Summary: Runs the Host Configuration utility. Run this command before 
starting Log Central.

Syntax: lc_config [-inifile initialization_file] [-conffile 
configuration_file] [-fn fontname] [-fs fontsize] 
[-h]
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lc_config
Options and 
Arguments:

-inifile initialization_file

Path for the initialization file to create. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. If you use a nondefault value, you need to set 
INIFILE in the messaging configuration file. For a 
description of the initialization file, see Appendix F, 
“Initialization File,” in the Log Central Configuration 
Guide. For a description of the messaging configuration 
file, see Appendix, G, “Configuration Files,” in the Log 
Central Configuration Guide.

-conffile configuration_file

Path for the messaging configuration file to create. The 
default is install_dir/etc/messaging.conf, where 
install_dir is the directory where you installed Log 
Central. If you use a nondefault location, set the 
BEA_LC_HOST_CONF environment variable. For a 
description of the messaging configuration file, see 
Appendix G, “Configuration Files,” in the Log Central 
Configuration Guide. For a description of 
BEA_LC_HOST_CONF, see Appendix C, 
“Environment Variables,” in the Log Central 
Configuration Guide. 

-fn fontname

Name of the font to use in the Host Configuration utility.

-fs fontsize

Size of the font to use in the Host Configuration utility.

-h

Displays help information about the command.

Description: This command runs the Log Central Host Configuration utility, 
which creates the initialization file and the messaging 
configuration file. For more information, see Chapter 3, 
“Configuring the Central Host,” in the Log Central Configuration 
Guide.
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lc_create_schema

lc_drop_schema

Summary: Creates a database schema. Run this command before starting Log 
Central.

Syntax: lc_create_schema [-inifile inifilename] [-h]

Options and 
Arguments:

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command creates the database table definitions that Log 
Central uses to store messages and message definitions. For a 
description of these tables, see Appendix E, “Database Schema,” 
in the Log Central Configuration Guide. 

If an error occurs or if lc_create_schema aborts, run 
lc_drop_schema to clean up files that may have been created, try 
to correct the problem, and recreate the schema.

Summary: Drops a database schema. Run this command before starting Log 
Central.

Syntax: lc_drop_schema [-inifile inifilename] [-h]
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lc_launch

Options and 
Arguments:

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command drops the Log Central database schema. 

If lc_create_schema aborts, you need to call lc_drop_schema 
before calling lc_create_schema again. Ignore all error 
messages that lc_drop_schema generates because it may try to 
drop tables and synonyms that were not created. You might also 
run lc_drop_schema before reinstalling Log Central. 

For a description of the database schema, see Appendix E, 
“Database Schema,” in the Log Central Configuration Guide.

Summary: Starts the Log Central Console.

Syntax: lc_launch [-p port] [-h central_host] [-n msgs] [-fn 
fontname] [-fs fontsize] [-b browser] [-h]
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lc_user_create

Options and 
Arguments:

-p port

Message Processor’s port number. The default is 7001.

-h central_host

Name of the machine that the Central Collector is running 
on. If you do not provide this value, the machine on which 
you are running this command is considered to be the 
central host.

-n msgs

Maximum number of messages or message definitions to 
display. The default is 1000.

-fn fontname

Name of the font for displaying text in the Log Central 
Console. The default is Times Roman.

-fs fontsize

Size of the font for displaying text in the Log Central 
Console. The default is 12 points.

-b browser

Web browser for displaying the Log Central Online Help. 
Use the name of an executable that is available in the 
current PATH, or provide a complete pathname. The 
default is Netscape Navigator.

-h

Displays help information about the command.

Description: This command starts the Log Central Console. For information 
about the Console, see the Log Central Online Help.

Summary: Creates a user in the database. You can run this command while 
Log Central is running.

Syntax: lc_user_create -u username -p password [-inifile 
inifilename] [-h]
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lc_user_delete

Options and 
Arguments:

-u username

Name of the user to create. This value can be up to 10 
characters and can contain any alphanumeric character, 
including a hyphen or underscore.

-p password

User password. This value can be up to 10 characters and 
can contain any printable ASCII character.

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command creates a new user in the Log Central database.

Summary: Deletes a user from the database. You can run this command while 
Log Central is running.

Syntax: lc_user_delete -u username -p password [-inifile 
inifilename] [-h]
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lc_user_modify

Options and 
Arguments:

-u username

Name of the user to delete.

-p password

Password of the user to delete.

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command deleted a user from the Log Central database.

Summary: Changes a user’s password in the database. You can run this 
command while Log Central is running.

Syntax: lc_user_modify -u username -p oldpassword -n 
newpassword [-inifile inifilename] [-h]
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lc_user_list

Options and 
Arguments:

-u username

Name of the user.

-p oldpassword

User’s current password.

-n newpassword

User’s new password. This value can be up to 10 
characters and can contain any printable ASCII character.

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command changes a user password in the Log Central 
database.

Summary: Lists all the users in the database. You can run this command while 
Log Central is running.

Syntax: lc_user_list [-inifile inifilename] [-h]
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log_monitor

Options and 
Arguments:

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command lists all the users in the Log Central database.

Summary: Starts a Log Monitor or forwards log files.

Syntax: To start a Log Monitor with predefined mappings:
log_monitor -i filename -P 
predefined_mapping [-t time] [-p pattern] [-x 
pattern] [-e entityname] [-h]

To start a Log Monitor with mappings in a message mapping file:
log_monitor -i filename -f mapping_filename 
[-t time] [-c] [-e entityname] [-h]

To start a Log Monitor with mapping specified on the command 
line and optional predefined mapping:

log_monitor -i filename [-P 
predefined_mapping] [-t time] [-e 
entityname] [-b body] [-D date_and_format] 
[-d msgid] [-I processID] [-M log_level] [-m 
subsystem] [-n function] [-o hostname] [-p 
pattern] [-S separators] [-u userID] [-x 
pattern] [-h]

To forward log files:
log_monitor -i filename -P 
predefined_mapping -e entityname [-h]
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Options and 
Arguments:

-i filename

Incoming log file to use. You can use a hyphen to specify 
standard input:

-i -

To forward log files, set filename to pathname/file* 
where pathname is the directory that contains the log 
files and file specifies the characters that are the same in 
each log file name. For example, filename could be:

C:\tuxedo\logfiles\ULOG*

-P predefined_mapping

Tells the Log Monitor to use predefined mapping. 
Possible values:

LM—Log Central temporary log files. For more 
information, see “Using the LM Predefined Mapping” in 
the Description section.

NTEVENT—Windows NT event log

ORACLE—Oracle alert logs

TUXEDO—BEA Tuxedo user logs

-t time

Length of time to wait between forwarding each log 
message. The default is one second. Use 0 to forward 
once and then stop. Using 0 causes the Log Monitor to run 
as a daemon.

-e entityname

Entity name that the Log Monitor uses to register with the 
proc_monitor process. The default is log_monitor. 
Each Log Monitor on one managed node must have a 
unique entity name. If you run a Log Monitor as a daemon 
(with -t 0), this option is not used.

-f mapping_filename

Message mapping file that contains the mappings.

-c

Applies the mappings in the message mapping file to a 
log message only up to the first match.
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-h

Displays help information about the command.

For descriptions of the remaining options, see Table 5-2 in Chapter 
5, “Creating Log Mappings,” in the Log Central Configuration 
Guide.

Description: This command starts a Log Monitor manually. To start log 
monitors automatically, use the start_messaging command. For 
information about mapping, see Chapter 5, “Creating Log 
Mappings,” in the Log Central Configuration Guide.

Using the LM Predefined Mapping

Log Central creates temporary log files. There are two abnormal 
situations where you might need to use Log Monitor to recover the 
contents of these files:

n A Message Sender writes log messages to a temporary file if 
the Central Collector is unavailable. When the Central 
Collector becomes available, the Message Sender 
automatically forwards the log messages from the temporary 
file to the Central Collector. If the Message Sender dies 
before it can recover the file, the temporary file may not be 
recovered automatically. If this happens, you can use the LM 
predefined mapping to recover the contents of the temporary 
file.

n The Message Receiver writes incoming messages to an 
intermediate file, and the Message Processor reads this file to 
insert log messages into the database. If the Message 
Processor does not process an intermediate file, you can use 
the LM predefined mapping to recover the contents of the 
intermediate file.
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msgdef_delete

Summary: Deletes message definitions from the database. Run this command 
before starting Log Central.

Syntax: msgdef_delete [-f filename] [-inifile inifilename] 
[-h]

Options and 
Arguments:

-f filename

Path for the file that contains the message definitions to 
delete. Only the subsystem names and message IDs are 
necessary. If you do not provide a file name, 
msgdef_delete accepts text from the standard terminal 
input. For a description of the message definition file, see 
Chapter 6, “Creating Message Definitions,” in the Log 
Central Configuration Guide. 

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command deletes message definitions from the Log Central 
database. You can also use the subsystem_delete command to 
delete message definitions.
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msgdef_export

Summary: Copies message definitions from the database to a text file. You 
can run this command while Log Central is running.

Syntax: msgdef_export [-f filename] [-s subsystem_name 
[subsystem_name]...] [-inifile inifilename] [-h]

Options and 
Arguments:

-f filename

Path for the file that contains the message definitions to 
delete. Only the subsystem names and message IDs are 
necessary. If you do not provide a file name, 
msgdef_export accepts text from the standard terminal 
input. For a description of the message definition file, see 
Chapter 6, “Creating Message Definitions,” in the Log 
Central Configuration Guide. 

-s subsystem_name

Name of the subsystem for which to copy the message 
definitions. You can provide multiple subsystem_name 
values to copy message definitions for multiple 
subsystems. If you do not provide a subsystem name, 
msgdef_export copies the message definitions for all 
the subsystems.

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command copies message definitions from the Log Central 
database to a text file. 
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msgdef_import

msg_reader

Summary: Loads a message definition file into the database. You can run this 
command while Log Central is running.

Syntax: msgdef_import [-f filename] [-inifile inifilename] 
[-h]

Options and 
Arguments:

-f filename

Path for the file that contains the message definitions to 
delete. If you do not provide a file name, msgdef_export 
accepts text from the standard terminal input. For a 
description of the message definition file, see Chapter 6, 
“Creating Message Definitions,” in the Log Central 
Configuration Guide. 

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command loads a message definition file into the Log Central 
database.

Summary: Displays the current intermediate log file.

Syntax: msg_reader [-e] [-n] pathname [-h]
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msg_test

Options and 
Arguments:

-e

Starts writing from the end of the intermediate file.

-n

Formats the logged messages before writing them. Do not 
use this option if you run msg_reader with 
log_monitor.

pathname

Pathname of the file to open for reading. The command 
adds the .cur extension to the pathname before opening 
the file.

-h

Displays help information about the command.

Description: This command continuously reads the current intermediate file that 
the Message Receiver constructs, and writes the file contents to the 
standard output.

Summary: Generates test messages.

Syntax: msg_test [-i] [-l length] [-n messages] [-s 
subsystem] [subsystem]...] [-t interval] [-h]
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show_config

Options and 
Arguments:

-i

Invokes the interactive mode. The -i option overrides the 
-t option.

-l length

Message body length. The default is 40.

-n messages

Number of messages to generate. The default is 1.

-s subsystem

Subsystem name to use in the message header. You can 
specify multiple subsystems. The default is LC.

-t interval

Time interval, in seconds, to wait between messages. The 
default is 0.

-h

Displays help information about the command.

Description: This command tests the flow of messages. You can also use this 
command to print performance data. Use the Message Browser in 
the Log Central Console to see the test results. 

For information about the Log Central Console, see Chapter 2, 
“Introducing the Log Central Console.”

Summary: Checks the syntax of the messaging configuration file or displays 
information about Log Central.

Syntax: show_config -c [-f config_file] | -g | -p | -d | -n 
entity_name [-h]
Log Central Online Help B-17



B Commands
Options and 
Arguments:

-c

Checks the messaging configuration file for syntax errors.

-f config_file

Name of the messaging configuration file. If you do not 
specify a name, show_config uses messaging.conf.

-g

Displays the Log Central shared memory information to 
stdout.

-p

Displays the Process Monitor shared memory 
information to stdout.

-d

Displays the Log Central and Process Monitor shared 
memory information to stdout. This option is the same 
as using -g and -p.

-n entityname

Displays detailed information about the specified entity 
(process) to stdout. Possible values for entityname:

log_monitor
msg_processor
msg_receiver
msg_sender
proc_monitor
start_messaging

-h

Displays help information about the command.

Description: This command checks the syntax of the messaging configuration 
file or displays information about Log Central. For a description of 
the messaging configuration file, see Appendix G, “Configuration 
Files,” in the Log Central Configuration Guide.
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start_messaging

Summary: Starts the Log Central processes.

Syntax: start_messaging [-f config_file] [-q] [-v] 
[central_host] [backup_central_host] [-h]

Options and 
Arguments:

-f config_file

Name of the Log Central messaging configuration file to 
use instead of messaging.conf. This option is available 
only for Central Collectors.

-q

Makes the process quiet, which means that no 
informational messages are displayed.

-v

Displays informational and debug messages.

central_host

Host name of the machine for the primary Central 
Collector. If you do not provide this name, the machine 
on which you are running this command is considered to 
be the central host. You must provide this name when you 
run start_messaging on a backup host or a managed 
node.

backup_central_host

Host name of the machine for the secondary Central 
Collector. You do not need to provide this value for the 
central host unless you are running a Data Collection 
Agent on the central host, in addition to the primary 
Central Collector.

-h

Displays help information about the command.
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Description: This command starts the Log Central processes for a Central 
Collector or a Data Collection Agent.

For a Central Collector, start_messaging starts the following 
processes:

n Message Receiver (msg_receiver)

n Message Processor (msg_processor)

n Process Monitor (proc_monitor)

n Message Sender (msg_sender)

n If you included LOG_MONITOR statements in the 
MANAGED_NODE entry in the messaging configuration file, 
then start_messaging also starts the specified Log 
Monitors.

For a Data Collection Agent, start_messaging starts the 
following processes:

n Message Sender (msg_sender)

n Process Monitor (proc_monitor)

n If you included LOG_MONITOR statements in the 
MANAGED_NODE entry in the messaging configuration file, 
then start_messaging also starts the specified Log 
Monitors.

The start_messaging process on a managed node uses the UDP 
service, which is defined by the BEA_LC_CONF_SERVICE 
environment variable, to connect to the start_messaging 
process on the central host. Then the start_messaging process 
on the central host downloads the local host’s messaging 
configuration. If BEA_LC_CONF_SERVICE is not defined, 
start_messaging uses the lc_conf service.

The Process Monitor monitors the start_messaging process to 
make sure that it continues to run and restarts it if it dies. The 
start_messaging process monitors the proc_monitor process 
and restarts it if it dies.
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stop_messaging

subsystem_create

Summary: Stops the Log Central processes.

Syntax: stop_messaging [-q] [-v] [-h]

Options and 
Arguments:

-q

Makes the process quiet, which means that no 
informational messages are displayed.

-v

Displays informational and debug messages.

-h

Displays help information about the command.

Description: This command stops the Log Central processes.

Summary: Creates a subsystem in the database. You can run this command 
while Log Central is running.

Syntax: subsystem_create -s subsystem_name [subsystem_name] 
-d subsystem_description [-inifile inifilename] 
[-h]
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subsystem_delete

Options and 
Arguments:

-s subsystem_name

Name of a subsystem. This value can be up to eight 
characters, must be entirely in upper case, and must be 
unique in the Log Central database. You can provide 
multiple subsystem_name values to create multiple 
subsystems.

-d subsystem_description

Short description of the subsystem. This value can be up 
to 40 characters. If it contains more than one word, 
enclose the entire value in double quotes.

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command creates a subsystem in the Log Central database. 
You might want to partition the Log Central database, separating 
various messages (such as NT events, Oracle messages, BEA 
Tuxedo messages, and so on) into different categories. Each 
category represents a resource that generates messages. These 
resources are called subsystems. The subsystem is one of the 
unique attributes in a log message.

Summary: Deletes a subsystem from the database. You can run this command 
while Log Central is running.

Syntax: subsystem_delete -s subsystem_name [subsystem_name] 
[-inifile inifilename] [-h]
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Options and 
Arguments:

-s subsystem_name

Name of a subsystem. You can provides multiple 
subsystem_name values to delete multiple subsystems.

-inifile inifilename

Path for the initialization file. The default is 
install_dir/etc/msg_processor.ini, where 
install_dir is the directory where you installed Log 
Central. For a description of the initialization file, see 
Appendix F, “Initialization File,” in the Log Central 
Configuration Guide.

-h

Displays help information about the command.

Description: This command deletes a subsystem from the Log Central database. 
The command deletes all the message definitions for the 
subsystem, but does not delete the messages.
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APPENDIX
C SNMP Traps

The following table describes the SNMP traps that Log Central defines. You can use 
these trap values when you define basic SNMP traps. For information about basic 
SNMP traps, see Chapter 6, “Configuring SNMP Traps.” For information about 
setting up SNMP management, see Chapter 8, “Integrating SNMP,” in the Log Central 
Configuration Guide.

 

Table C-1  Log Central SNMP Traps

Trap Description

90010 General trap

90011 Information trap

90012 Warning trap

90013 Minor trap

90014 Major trap

90015 Critical trap
Log Central Online Help C-1



C SNMP Traps
C-2 Log Central Online Help



Index

A
acknowledgment

in messages A-14
architecture 1-3

B
backup Central Collector. See secondary 

Central Collector.
Basic Trap Configuration tool 6-2
BEA Tuxedo log

forwarding B-10

C
Central Collector

overview 1-7
stopping B-21
See also secondary Central Collector.

central host
configuration utility B-2
defining with lc_launch B-6

Color Settings window 3-10
colors, changing 3-9
console. See Log Central Console.
customer support contact information ix

D
Data Collection Agents

overview 1-5
stopping B-21

database records
deleting 7-6
processing on a schedule 7-13
processing one time 7-11

database schema
creating B-4
dropping B-4

database users
adding B-6
changing B-8
creating B-6
deleting B-7
listing B-9

database, querying 3-11
date

in messages A-5
debugging 8-1
description

in messages A-11
documentation, where to find it viii

E
entity

in messages A-8
executable

in messages A-12

F
fault tolerance 1-12
Filter Settings window 3-13
Log Central Online Help I-1



function
in messages A-8

G
generating reports 5-1

H
host name

in messages A-6

I
initialization file

defining with lc_config B-3
intermediate files

deleting 7-8
displaying B-15
overview 1-7
processing 7-13
recovering B-12

Intermediate Message File tab 7-9

L
Launch Panel 2-2
layout

Message Browser 3-7
Message Definition Editor 4-8

lc_config B-2
lc_create_schema B-4
lc_drop_schema B-4
lc_launch B-5
lc_user_create B-6
lc_user_list B-9
lc_user_modify B-8
Log Central Console

overview 1-13
starting 2-1

log ID
in messages A-4

log mappings. See mappings.
log messages. See messages.
Log Monitor

log_monitor B-10
overview 1-6

logging level
in messages A-4

M
mappings

defining B-10
maximum messages, defining with lc_launch 

B-6
menus

Message Browser 3-6
Message Definition Details 4-10
Message Definition Editor 4-6
Storage Maintenance tool 7-5

message body
in messages A-9

Message Browser
appearance 3-3
color settings 3-10
filter settings 3-13
layout 3-7
Layout window 3-8
main components 3-3
menus 3-6
starting 3-2
toolbar 3-4

Message Definition Details
menu 4-10
window 4-15

Message Definition Editor
appearance 4-3
Filter Settings window 4-12
layout 4-8
Layout window 4-9
main components 4-3
menus 4-6
I-2 Log Central Online Help



starting 4-2
toolbar 4-4

message definitions
adding 4-14
changing 4-16
changing layout 4-8
copying B-14
deleting 4-18
displaying 4-10
example of format A-2
filtering 4-11
format A-9
loading B-15
viewing 3-19

message header A-3
message ID

in messages A-6
Message in Database tab 7-7
Message Processor 1-8
Message Receiver 1-8
Message Sender 1-6
messages

acknowledging 3-17
changing layout 3-7
construction 1-8
deleting 3-16
example of format A-2
format A-1
monitoring 3-11
removing acknowledgments 3-18

messaging configuration file
compiling B-17
defining with lc_config B-3
displaying B-17

msg_processor. See Message Processor.
msg_reader B-15
msg_receiver. See Message Receiver.
msg_sender. See Message Sender.
msg_test B-16
msgdef_delete B-13
msgdef_export B-14

msgdef_import B-15

O
Operations Settings window 7-7

P
PATH

for Web browser 2-1
performance data, printing B-16
ports

defining with lc_launch B-6
printing product documentation viii
proc_monitor. See Process Monitor.
process ID

in messages A-7
Process Monitor 1-11
processing script

creating 7-10
running one time 7-11
scheduling 7-13

R
recommendation

in messages A-12
related information ix
reports

generating 5-1
viewing (message definition report) 5-2
viewing (message report) 5-1

S
secondary Central Collector

overview 1-12
See also Central Collector.

severity
in messages A-11

shared memory, displaying B-17
show_config B-17
Log Central Online Help I-3



SNMP
integration 1-12

SNMP traps
advanced 1-12
basic 1-12
configuring basic 6-1
numbers C-1
See also trap ID.

start_messaging B-19
stop_messaging B-21
Storage Maintenance tool

appearance 7-3
main components 7-4
menus 7-5
starting 7-2
toolbar 7-4

subsystem
changing description 4-19
creating B-21
deleting B-22
in messages A-5

Subsystem Definition window 4-20
summary

in messages A-10
support

technical ix

T
tabs

Intermediate Message File 7-9
Messages in Database 7-7
Trap Configuration 6-3
Trap Generation 6-2

temporary files
description 1-13
recovering B-12

test messages B-16
testing 8-1
timestamp. See date.
toolbars

Message Browser 3-4
Message Definition Editor 4-4
Storage Maintenance tool 7-4

tools
Basic Trap Configuration 6-2
Storage Maintenance 7-3

Trap Configuration tab 6-3
trap enabled

in messages A-13
See also SNMP traps.

Trap Generation tab 6-2
trap ID

in messages A-13
See also SNMP traps.

Tuxedo log
forwarding B-10

U
user ID

in messages A-7

W
Web browser, defining B-6
windows

Basic Trap Configuration 6-2
Color Settings 3-10
Filter Settings 3-13
Launch Panel 2-2
Message Browser 3-3
Message Browser Layout 3-8
Message Definition Details 4-15
Message Definition Editor 4-3
Message Definition Editor Filter 

Settings 4-12
Message Definition Editor Layout 4-9
Operations Settings 7-7
Storage Maintenance tool 7-3
Subsystem Definition 4-20
I-4 Log Central Online Help


	Contents
	About This Online Help
	What You Need to Know
	e-docs Web Site
	How to Print the Document
	Related Information
	Contact Us!
	Documentation Conventions

	1 Overview
	Log Messages in System Management
	Log Messages in Log Central
	Log Central Architecture
	Overview of Log Central Architecture
	Data Collection Agent
	Log Monitor
	Message Sender
	Central Collector
	Message Receiver
	Message Processor

	Construction of Log Messages
	Log Central Processes
	Overview of the Log Central Processes
	Process Monitor

	SNMP Integration
	Fault Tolerance
	Log Central Console

	2 Introducing the Log Central Console
	3 Managing Log Messages
	Working with the Message Browser
	Starting the Message Browser
	Main Components of the Message Browser
	Message Browser Toolbar
	Message Browser Menus
	Changing the Log Message Layout
	Changing Severity Colors

	Monitoring Incoming Log Messages
	Querying the Database
	Filtering Log Messages
	Deleting Log Messages
	Acknowledging Log Messages
	Removing Acknowledgments
	Viewing Log Message Definitions

	4 Changing Message Definitions and Subsystem Descriptions
	Working with the Message Definition Editor
	Starting the Message Definition Editor
	Main Components of the Message Definition Editor
	Message Definition Editor Toolbar
	Message Definition Editor Menus
	Changing the Message Definition Layout
	Working with the Message Definition Details File Menu

	Displaying Message Definitions
	Filtering Message Definitions
	Adding a Message Definition
	Changing a Message Definition
	Deleting Message Definitions
	Changing a Subsystem Description

	5 Generating Reports
	Generating a Message Report
	Generating a Message Definition Report

	6 Configuring SNMP Traps
	7 Managing the Database and Intermediate Files
	Working with the Storage Maintenance Tool
	Starting the Storage Maintenance Tool
	Main Components of the Storage Maintenance Tool
	Storage Maintenance Tool Toolbar
	Storage Maintenance Tool Menus

	Deleting Database Records
	Deleting Intermediate Files
	Creating a Processing Script
	Processing Records on a One-Time Basis
	Processing Records and Files on a Schedule

	8 Testing and Debugging
	A Log Central Message and Message Definition Formats
	Example of a Log Central Message and Message Definition
	Message Header
	Log ID
	Logging Level
	Date and Time
	Subsystem
	Message ID
	Host
	Process ID
	User ID
	Function
	Entity

	Message Body
	Message Definition
	Summary
	Severity
	Description
	Recommendation
	Execute on Upload
	Trap ID
	Trap Enabled
	Auto Acknowledge


	B Commands
	lc_config
	lc_create_schema
	lc_drop_schema
	lc_launch
	lc_user_create
	lc_user_delete
	lc_user_modify
	lc_user_list
	log_monitor
	msgdef_delete
	msgdef_export
	msgdef_import
	msg_reader
	msg_test
	show_config
	start_messaging
	stop_messaging
	subsystem_create
	subsystem_delete

	C SNMP Traps
	Index

